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What's New 
July 10, 2020 (1.0.4.5959) 
- CalibrateDSX: Added the "Re-correct Current Trial" command. 
- CalibrateDSX: Bug fix: X-ray images were improperly clipped when panning and zooming in the 2D 
windows. 
- CalibrateDSX: Bug fix: Grid Centroid Size Range values were being reset too often. 
- Locate3D: Bug fix: X-ray images were improperly clipped when panning and zooming in the 2D 
windows. 
- Locate3D: Bug fix: in graphs, snapping of the cursor to data points did not work. 
- PlanDSX: Added "Save Configuration As" to the File menu and changed the behavior of "Save 
Configuration" accordingly. 
- PlanDSX: Bug fix: crash when loading any motion from a CMZ. 
- PlanDSX: Bug fix: crash when loading a configuration that contained objects with empty file paths. 
- PlanDSX: Bug fix: 2D DRR windows did not show DRRs if they were opened before DRRs were 
generated. 
- PlanDSX: Bug fix: cancelling a file-open command should not clear the existing file path. 
- xManager: Added the "Reset to Defaults" button to the Program Links dialog. 
- X4D:  Bug fix: 4D solving did not work with the conditional entropy metric. 
- General: The mouse wheel has been disabled in the configuration widget in all applications so it 
can no longer change the session, configuration, or trial. 
 
June 24, 2020 (1.0.4.5892) 
- Surface3D: Bug fix: Save Subject command in File menu did not get enabled after parameters were 
changed. 
- X4D:  Bug fix: crash if an object was deselected in the Configuration widget while selected for 
moving in an X-ray window. 
- X4D:  Bug fix: DRR was still displayed after an object was deselected. 
- xManager: Bug fix: launching an application while no subject file was loaded in xManager caused the 
application to start with the subject file that was last loaded into the program. 
 
June 19, 2020 (1.0.4.5883) 
- CalibrateDSX: White and grid images now update in real time as relevant calibration parameters 
are changed. 
- CalibrateDSX: Added an option to display the grid-check images in the X-ray windows (G key). 
- CalibrateDSX: Separated the white_threshold parameter into white_threshold_view1 and 
white_threshold_view2. 
- CalibrateDSX: Added help text to the 2D windows. 
- CalibrateDSX: Added the grid_centroid_max_size parameter. 
- CalibrateDSX: Improved some error and output messages related to creating the mocap model. 
- CalibrateDSX: Bug fix: default positioning of X-rays in 2D windows was not ideal. 
- CalibrateDSX: Bug fix: landmarks and POIs disappeared from the display when the segmentation label 
was masked or cropped. 
- CalibrateDSX: Bug fix: fixed several small bugs related to adding, deleting, and renaming POIs. 
- Locate3D: Added the ability to specify the order of rotations for body poses, to help avoid 
gimbal lock. 
- Locate3D: Added help text to the 2D windows. 
- Locate3D: Bug fix: fixed several small bugs related to adding, deleting, and renaming POIs. 
- Locate3D: Bug fix: default positioning of X-rays in 2D windows was not ideal. 
- Orient3D: Bug fix: the Miranda tibia algorithm would sometimes point the bone's long axis in the 
wrong direction. 
- Orient3D: Bug fix: ROI projection did not work if the ROI had been manually adjusted. 
- Surface3D: Added an option to calculate the weighted center when defining POIs and landmarks. 



- Surface3D: Bug fix: loading a segmentation label from a file sometimes would not work properly. 
- Surface3D: Bug fix: segmentation label and image histogram thresholds were not updated after the 
image data was cropped. 
- Surface3D: Bug fix: manual label edits were lost if the image data was cropped before being masked. 
- Surface3D: Bug fix: the image data histogram did not fully clear when the data was unloaded. 
- Surface3D: Bug fix: mouse wheel scaling of paint/erase cursor did not work properly. 
- X4D:  Added the ability to specify the order of rotations for body poses, to help avoid 
gimbal lock. 
- X4D:  Reorganized the tracking parameters that are specific to certain metric algorithms. 
- X4D:  Added more actions to the context menu in the 2D windows. 
- X4D:  Added an option to center the selected object in the 2D windows (C key). 
- X4D:  Added the Fill Pose Maps command (fills the tracking range with poses). 
- X4D:  Added the Clean Pose Maps command (removes poses that are not at a reporting time). 
- X4D:  Bug fix: X-ray/DRR settings were not being applied properly when tracked objects were 
selected and deselected. 
- X4D:  Bug fix: the GUI is now disabled/enabled properly based on which optimizer is running. 
- X4D:  Bug fix: image optimization could not be stopped easily, and would sometimes crash. 
- X4D:  Bug fix: pose maps didn’t import properly if the units were different than the subject units. 
- X4D:  Bug fix: graphs did not show any poses if there was only one reporting time in the trial. 
- xManager: Added bead/hole radius to the grid object definition, to help with calculation of the 
expected pixel size of grid beads/holes. 
- xManager: Improved the display and specification of the LCS transform and the Mocap transform. 
- xManager: Undefined transforms are now displayed as an empty matrix instead of the identity 
matrix.  
- xManager: Added an option to update POI files when the C3D file name is changed for a trial. 
- xManager: Added an option to update transform files when a subject object is renamed. 
- xManager: Added an option to update transform files when a mocap segment name is changed. 
- xManager: Added an option to update landmark and transform files when a trial's C3D file is 
changed. 
- xManager: Added options to update landmark and transform files when any file parameter is 
changed. 
- xManager: Added an option to update tracked object files when the units are changed. 
- xManager: Added an option to update all dependent files when the mocap time offset is changed for 
a trial. 
- xManager: Bug fix: the tracked object and X-ray view panels did not always update properly when 
switching between trials. 
- General: Added an option to update all landmark files when a landmark is deleted using any 
application. 
- General: Added an option to update all POI files when a POI is deleted using any application. 
 
March 11, 2020 (1.0.4.5582) 
- CalibrateDSX: Pressing the Esc key now clears the current POI selection. 
- CalibrateDSX: Bug fix: crosshairs for perfect POI locations were not updated when POI colors changed. 
- Orient3D: Before an ROI is projected, its name is now checked to make sure it is unique. 
- Orient3D: Bug fix: the -X orientation did not work properly for rectangle ROIs. 
- Orient3D: Bug fix: the Project and Adjust buttons were not immediately enabled after placing an 
ROI. 
- Surface3D: Bug fix: pressing the '3' and 'f' keys changed the 2D slice views in undesireable ways. 
- Surface3D: Bug fix: the 's' key to toggle label display did not work in the 2D slice windows. 
- Surface3D: Added help text to the 2D slice windows. 
- X4D:  Added the ability in the pose map widget to specify which pose maps are modified 
by the other commands. 
- X4D:  Bug fix: x-ray images were sometimes colored red. 
- X4D:  Bug fix: using 'Open with' with subject files did not launch X4D. 
- X4D:  Added 'toggle help' to the context menu. 
- xManager: Added "clone" and "clone (template)" commands for sessions, configurations, and 



trials. 
- xManager: Bug fix: x-ray file attributes sometimes did not get written to the subject file. 
- xManager: Bug fix: using 'Open with' with subject files did not launch xManager. 
- xManager: Bug fix: trial x-ray paths were colored red if they were empty when first displayed. 
 
February 21, 2020 (1.0.4.5539) 
- X4D:  Added help text for keyboard commands in the X-ray windows. 
- X4D:  The keyboard commands to move objects now move only the objects selected in the 
Tracking widget. 
- X4D:  The 3D window can now be maximized. 
- X4D:  When an object is selected in the 3D window it is rendered semi-transparent, making it 
easier to grab the trackball handles. 
- X4D:  Bug fix: the scene in the 3D window became mangled after several mouse interactions. 
- General: Added support for importing RGB X-ray images (they are converted to grayscale). 
 
February 6, 2020 (1.0.4.5520) 
- CalibrateDSX: Bug fix: image size in the Calibration Parameters widget was not always initialized 
properly when selecting a new configuration. 
- CalibrateDSX: Bug fix: loading trials that bypassed distortion correction gave unnecessary errors. 
- General: The TIFF module was enhanced to support import of additional TIFF formats. 
 
February 3, 2020 (1.0.4.5516) 
- CalibrateDSX: Replaced the generic parameters widget with the Calibration Parameters widget. 
- CalibrateDSX: Implemented masks for POI digitization. When digitizing a POI, it cannot be placed over 
an existing POI. 
- CalibrateDSX: Added code to make sure all images files have the same bit depth. 
- CalibrateDSX: POIs in the POI Widget can now be sorted alphabetically by click on the header of the 
name column. 
- Locate3D: Replaced the generic parameters widget with the POI Parameters Widget. 
- Locate3D: POIs are now output to the CMZ file when object poses are output. 
- Locate3D: POIs in the POI Widget can now be sorted alphabetically by click on the header of the 
name column. 
- Locate3D: Implemented masks for POI digitization. When digitizing a POI, it cannot be placed over 
an existing POI. 
- Orient3D: Removed the generic parameters widget and moved the parameters to the ROI widget. 
- Orient3D: A placed ROI is now updated automatically when any of its parameters are changed. 
- Orient3D: Bug fix: scaling of global axes was sometimes incorrect when loading multiple surfaces. 
- Orient3D: Bug fix: the Miranda femur algorithm would sometimes give incorrect results on bones 
with holes in the surface. 
- PlanDSX: Replaced the generic parameters widget with a dialog accessible from the Options menu. 
- Surface3D: Removed the generic parameters widget and moved the parameters to various 
other widgets. 
- Surface3D: Added the ability to save label images to a file and re-load them later. 
- Surface3D: Added slice crosshairs to the 2D views. 
- Surface3D: Separating masking and cropping of image data, so each can be performed independent 
of the other. 
- Surface3D: The Home/End keys can now be used to go to the first/last slice in the 2D views. 
- Surface3D: The mouse wheel can now be used to increase/decrease the paintbrush radius when in 
paint or erase mode. 
- Surface3D: Improved how slice numbers are displayed. 
- Surface3D: Bug fix: loading an image file a second time did not work. 
- Surface3D: Bug fix: voxel size was not being set when outputting images files in the TIFF format. 
- X4D:  Removed the generic parameters widget and moved the parameters to various 
other widgets. 
- X4D:  Added a warning if the pose map times do not match the reporting times for a trial. 
- X4D:  Added a cutoff frequency slider to the graph widget. 



- X4D:  Added an option to turn off CPU threading. 
- X4D:  The Home/End keys can now be used to go to the first/last slice in the 2D views. 
- X4D:  Added output messages for each action in the pose map widget. 
- X4D:  Added a right-click context menu to the X-ray windows. 
- X4D:  Bug fix: DRR generation was incorrectly handling empty voxels. 
- X4D:  Bug fix: Alt-R shortcut to toggle display of local reference frames was not working. 
- xManager: Added a warning message if the time precision is set to a low value. 
- xManager: Bug fix: Empty scan data items could not be deleted. 
- xManager: Added "load folder" to scan data items. 
- General: Separated calibration objects from [trackable] subject objects. 
- General: Added grid objects that can be defined in xManager, replacing the five grid 
parameters in CalibrateDSX. 
- General: Added a dark color theme to the GUI for all apps (accessible via 
Options->Settings). 
- General: Many small fixes to reading and writing pose map, POI, landmark, and transform files 
(mostly header format changes). 
- General: Pose map cutoff frequency is now stored in the subject file for each pose map. 
- General: Bug fix: the backup subject file was not being deleted during Save Subject As. 
- General: Bug fix: copying network-drive files to a local drive before reading is now done for all files, 
not just X-ray files. 
 
October 16, 2019 (1.0.4.5234) 
- CalibrateDSX: Added a user parameter called Positive Frame Times for making all trial times positive. 
- CalibrateDSX: Bug fix: The "too few centroids" warning was actually an error, resulting in distortion 
correction being skipped. 
- Orient3D: Improved the naming of some vertebra landmarks. 
- Orient3D: Bug fix: the Image/Surface Match widget was sometimes not using the Render Threshold 
properly when creating the image surface. 
- Surface3D: Improved the display of slice numbers in the 2D windows. 
- X4D:  Bug fix: tracking optimization frequently failed when only one GPU was used. 
- X4D:  Bug fix: the trackball in the 3D window did not work properly if the object did not have an 
LCS defined. 
- xManager: Added a command to make the current trial synchronous by adjusting the frame 
and reporting times. 
- General: Improved error messages when encountering errors reading image files. 
 
September 18, 2019 (1.0.4.5211) 
- CalibrateDSX: Bug fix: POI trails were not displayed properly. 
- CalibrateDSX: Added an option to compute and display "perfect" calibration bead 
locations. 
- CalibrateDSX: Bug fix: no error message was displayed if segment creation failed when building a 
mocap model. 
- CalibrateDSX: Bug fix: distortion correction algorithm should ignore grid images with only a few grid 
points. 
- CalibrateDSX: Added error dialog when 2D POI files are not imported properly. 
- Locate3D: Added the Save Pose Maps As command. 
- Locate3D: Improved the look of POI crosshairs. 
- Locate3D: Added error dialog when POI file is not imported properly. 
- Orient3D: Bug fix: disk ROI did not work for +X and -X orientations. 
- Orient3D: Bug fix: deleting ROI landmarks did not work properly. 
- Surface3D: Bug fix: the Unlabel Disconnected Regions command was broken. 
- X4D:  Added a bell sound when a tracking optimization finishes. 
- X4D:  Added error dialog when a pose map file is not imported properly. 
- xManager: Added support for negative mocap offset times, and added tool-tip text. 
- xManager: Bug fix: file path validity (red coloring) was not updated in some cases when a shortcut 
path was changed. 



- xManager: Bug fix: warning dialogs were displayed with every character change of a session path. 
- xManager: Bug fix: adding extra white space to frame times or reporting times messed up the time 
values. 
- xManager: Bug fix: when restored after an application finishes, xManager was not immediately 
checking for a modified subject file. 
- General: Bug fix: special characters in the subject ID would cause problems in the generation of 
default file names in save dialogs in all applications. 
- General: Bug fix: no error was reported when a file could not be written (several places in several 
applications). 
 
June 28, 2019 (1.0.4.5086) 
- CalibrateDSX: Implemented a minimum value for the Image Threshold parameter. 
- CalibrateDSX: Implemented individual licensing. 
- CalibrateDSX: Added information to the residuals dialog when computing the 3D configuration. 
- CalibrateDSX Bug fix: landmark names could conflict with landmarks used to create mocap segments in 
Visual3D model. 
- xManager: Bug fix: some session items did not update when paths were added, removed, or 
changed. 
- Locate3D: Added support for outputting object transform files. 
- Locate3D: Bug fix: fixed a possible crash while exporting landmark files. 
- Orient3D: Added code to prompt the user to update surface files when LCS changes or a surface is 
transformed. 
- Orient3D: Bug fix: Anderst algorithm often doesn't produce valid LCS transforms. 
- X4D:  Object poses can now be saved to CMZ files without first calculating the mocap seed 
poses. 
- X4D:  Bug fix: landmarks were not output to text files properly if the image data was 
auto-cropped. 
- X4D:  Bug fix: landmarks were not displayed properly in the 2D windows. 
- X4D:  Bug fix: transform files were padded with NaNs even if that option was not selected. 
- X4D:  Bug fix: fixed a bug in 4D optimization when using two graphics cards. 
- X4D:  Bug fix: current pose was added to the pose map before 4D optimization even if it wasn't 
within the optimization range. 
- X4D:  Bug fix: residuals need to be initialized when calculating mocap poses. 
- General: Made finding a C3D inside a CMZ more flexible (if full path is not found, just file name is 
used). 
- General: Standardized the format label for TIF/TIFF files to "tif", fixing a few small bugs. 
- General: Bug fix: enabling of "Visual3D Format" in file save dialogs should not depend on 
presence of C3D file. 
- General: Bug fix: TIFF image files did not support the "origin" field. 
- General: Bug fix: existing landmark files were not updated when landmark names were changed. 
 
June 5, 2019 (1.0.4.5003) 
- CalibrateDSX: Bug fix: disabled POIs are no longer used for calculation of 3D configuration. 
- CalibrateDSX: Bug fix: selection of POIs and landmarks could get mangled when adding, deleting, or 
selecting them. 
- Surface3D: Added 'Toggle Voxel Interpolation' menu item to toggle between NN and linear voxel 
interpolation for image display. 
- xManager: Bug fix: changing units and time precision did not work properly. 
- xManager: Bug fix: invalid ScanData paths are now displayed in red. 
- xManager: Bug fix: ScanData paths were not properly updated when shortcut paths were added, 
removed, or modified. 
- X4D:  Bug fix: not all 'new best pose' messages were displayed for 'solve range' optimization. 
- X4D:  Bug fix: improved graph display when data is scaled to the control points. 
- General: Bug fix: Negative frame numbers and reporting times were not handled properly. 
- General: Added option to output NaNs for missing data in pose map, landmark, and transform 
files. 



- General: Bug fix: mocap segment name was not written to subject file properly. 
 
May 9, 2019 (1.0.4.4967) 
- CalibrateDSX: Added and improved error messages when correcting xray image files. 
- Orient3D: Bug fix: an object's LCD transform was corrupted when the object was loaded a second 
time. 
- Orient3D: Bug fix: the main window title did not always show the subject file and image file. 
- Surface3D: Added the segmentation command "Unlabel Disconnected Regions." 
- Surface3D: Improved the display of POIs and landmarks, and added labels to them in the 2D 
windows. 
- Surface3D: Added the option to toggle visibility of the segmentation label by pressing the 's' key. 
- Surface3D: Changed the display of voxel data to solid rectangles instead of smoothed/interpolated 
ones. 
- Surface3D: Bug fix: manual hole filling did not work properly in the COR (Z slice) window. 
- Surface3D: Bug fix: surface models could have holes if the object label touched the image volume 
boundaries. 
- Surface3D: Various bug fixes to adding/deleting labels, loading new image files. 
- Surface3D: Bug fix: display of POIs and landmarks in the 2D windows was wrong after pressing 'r' to 
reset the camera. 
- Surface3D: Made the paint brush radius a decimal number instead of an integer; new minimum is 
now 0.5. 
- Surface3D: Bug fix: the paint brush cursor sometimes had the wrong color or shape when it was first 
displayed. 
- Surface3D: Bug fix: the main window title did not always show the subject file and surface file. 
- xManager: Bug fix: when a subject object was deleted, the associated tracked objects were not 
deleted from the trials. 
- General: Better handling of frame times when too many are specified in the subject file. 
- General: Fixed default frequency when creating frame times. 
 
Apr 22, 2019 (1.0.4.4939) 
- xManager: Added a button to clear the 3D configuration parameters for a view. 
- xManager: Added code to check for invalid and duplicate names of sessions, configurations, views, 
and objects. 
- xManager: Bug fix: file paths in widgets for the current object and trial were not updated when path 
variables were changed. 
- xManager: White space and most special charcaters are no longer allowed in path variable names. 
- xManager: Bug fix: scan data files could not be deleted from a session. 
- xManager: Bug fix: "relative" checkbox did not work if the subject file was opened by double-clicking 
on it. 
- X4D:  Added a label to the time widget to show when the trial is asynchronous. 
- X4D:  Fixed a bug that was causing excessive memory usage during tracking when the app 
was launched from xManager. 
- X4D:  Added error dialogs when writing of pose map files fails. 
- X4D:  Bug fix: occasional crash when selecting/deselecting objects in the 2D windows. 
 
Apr 12, 2019 (1.0.4.4929) 
- xManager: View names are now required to be unique. 
- xManager: Bug fix: source_to_image is now properly updated in the subject file when view names 
are changed. 
- xManager: Fixed a bug related to updating voxel size when switching image file format from dicom to 
tiff. 
- Orient3D: ROI names can no longer contain spaces. 
- Orient3D: Fixed a bug that caused a crash when loading a surface file without a subject. 
- Surface3D: Fixed a large memory leak. 
- Surface3D: Bug fix: cropping to labels did not work properly. 
- X4D:  Bug fix: after 4D tracking, transforms of tracked bones did not update properly. 



 
Mar 29, 2019 (1.0.4.4915) 
- xManager: Bug fix: landmark names could not be changed. 
- xManager: Bug fix: the first shortcut path was not editable. 
- CalibrateDSX: Fixed some window flickering problems with Quadro cards. 
- Orient3D: Fixed some window flickering problems with Quadro cards. 
- S3D:  Added a warning message when saving surface files when an ROI surface file already 
exists. 
- X4D:  Fixed a bug related to clearing posemap graphs when a new trial is selected. 
- X4D:  Fixed a bug that made the 2D interaction frame very small when an object was selected 
in the 3D window. 
- X4D:  Fixed a bug related to moving the wrong object during interaction in the 2D windows. 
- X4D:  Fixed a bug that crashed tracking optimization when view_weight = 1.0. 
- X4D:  Fixed a bug related to cleaing posemap graphs when the object combo is set to no 
object. 
- X4D:  Bug fix: mocap constraints were not being applied when posemap graphs were edited. 
- X4D:  Fixed several bugs in the application of mocap constraints when interacting with an 
object. 
- X4D:  Fixed a bug in the Evaluate command related to the names of the generated files. 
- X4D:  Bug fix: playback of local minima did not work for asynchronous trials. 
- X4D:  Bug fix: single-frame optimization was not adding the bone pose to the pose map for 
asynchronous trials. 
- X4D:  Fixed a bug that was causing a crash when performing single-frame optimization with 
asynchronous trials. 
- X4D:  Fixed a bug in the display of anatomical frames during 2D trackball interaction for 
asynchronous trials. 
- General: Fixed some bugs in the handling of shortcut paths and data file paths, especially when 
network drives are used. 
- General: Added support for negative frame and reporting times. 
 
Jan 11, 2019 (1.0.4.4719) 
- xManager: Selecting DICOM or TIFF format in image file widget now unsets the origin parameter. 
- xManager: Selecting DICOM format in image file widget now unsets the voxel size parameter. 
- xManager: Added option to Z-flip image data (reflect across the XY plane) during loading. 
- xManager: Fixed a bug that prevented the "load folder" option from working. 
- CalibrateDSX: Processed xray images now use red to show thresholding. 
- CalibrateDSX: Added a way to override the [DLT-calculated] pixel size when correcting the calibration 
trial. 
- CalibrateDSX: Fixed several bugs related to updating window level and slice number during various 
actions. 
- Locate3D: Fixed a bug in the selection and deselection of points in the POI graphs. 
- PlanDSX: Fixed several bugs related to selecting and generating DRRs for CT objects. 
- X4D:  Support has been added for calculating and displaying up to 32 DRRs at once. 
- X4D:  Fixed a bug that was resetting the parameters in the Image Optimization widget too often. 
- X4D:  Fixed a bug that was causing flickering of xray image intensity when changing reporting 
times. 
- General: Applications now give proper warning or error messages when CUDA cards or OpenGL 
graphics drivers are missing. 
- General: Improved the loading screens for most of the applications. 
- General: Added or improved descriptions of app parameters in all applications. 
 
Nov 19, 2018 (1.0.4.4559) 
- xManager: Added a command "apply path" to path shortcuts, so a newly created shortcut can be 
applied to existing file paths. 
- xManager: Added features and warning dialogs to adding and deleting path shortcuts. For example, 
when a shortcut is created it can be applied to existing files, and when deleted it is removed from all file 



paths. 
- xManager: Made the import of LCS transform matrices from files much more robust. 
- xManager: Fixed the bug that file paths could not be relative to the subject file folder unless they 
used a shortcut path. 
- xManager: Fixed the bug that re-loading a subject file after getting the "file modified" message would 
crash the program. 
- CalibrateDSX: Added the parameter "smoothing threshold", for adaptive averaging during smoothing. 
- CalibrateDSX: Improved the progress dialogs when correcting xray images. 
- CalibrateDSX: Fixed the bug that xray correction failed when the images were both padded and resized. 
- CalibrateDSX: Fixed the bug that POI propagation would not work unless there was at least one with 
poses in both views. 
- Locate3D: Fixed the bug that POI graphs were not updated when the pose map cutoff frequency 
was changed. 
- Locate3D: Added a command to recalculate 3D POI locations for asynchronous trials (for use after 
the pose map contains a few poses). 
- Locate3D: Improved the GUI behavior of the POI widget. 
- Orient3D: Improved the algorithm for generating image file data. 
- Orient3D: You must now Ctrl-left-click on the LCS frame in the 3D window to manipulate it 
using the trackball. 
- Orient3D: Fixed the bug that projection of ROIs was broken. 
- Orient3D: Made the import of LCS transform matrices from files much more robust. 
- PlanDSX: You must now Ctrl-left-click on an object in the 3D window to manipulate it using 
the trackball. 
- PlanDSX: Several improvements to trackball interaction, including picking and placement of the 
trackball, and its behavior during scaling. 
- PlanDSX: 2D DRR windows now have a border color and title that matches the view in the view 
table. 
- PlanDSX: Fixed the bug that objects from OBJ files with material definitions were not being 
displayed properly. 
- PlanDSX: Fixed the bug that object files in configuration files were not able to use relative paths. 
- Surface3D: Fixed the bug that sometimes the scan data file loaded was not the one selected in the 
dialog. 
- X4D:  Improved the performance of 4D tracking via CUDA and CPU threading 
enhancements. 
- X4D:  Added a dialog with system information (CPU, GPU specs). 
- X4D:  Improved the options for selecting GPUs for each view. 
- X4D:  Fixed the bug that TIFF file of metric image for view 1 had a bad name (this file is output 
by the "Evaluate" command). 
 
Oct 8, 2018 (1.0.4.4481) 
- General: Changed the origin of CT image data to be consistent with the origin of xray images. 
Because of this change, if you want to load tracking results from a previous version of X4D into this 
version, you will need to add an offset to the reference frame definition of every tracked object. This offset 
is equal to half of the voxel size in each of the X, Y, and Z dimensions. 
- xManager: Prevented duplicate names for landmarks and pois. 
- xManager: Forcing ".dsx" extension when saving subject file. 
- xManager: Fixed a bug related to updating files in the calibration trials when the name of a POI or 
landmark was changed in an object. 
- xManager: Fixed a bug related to specifying the default frequency when an xray file is added to a 
trial. 
- xManager: Fixed a bug preventing pose maps from being updated when an object's LCS is changed. 
- CalibrateDSX: Added support for correcting xray images without performing distortion correction. 
- CalibrateDSX: Fixed a bug preventing CMZ files from being created if the path in the subject file is 
empty (X4D as well). 
- CalibrateDSX: Fixed a bug related to the calculation of the correct XY coordinates when Ctrl-click is 
used to pick a point. 



- CalibrateDSX: Fixed a bug related to aspect ratio of view 1 window when first trial is loaded (Locate3D 
as well). 
- Locate3D: Fixed a bug related to Y scaling of graphs when the Y range is zero (X4D as well). 
- Orient3D: Added a tool for generating image data (simulated CT) from surface models. 
- Orient3D: Added support for specifying an "inner" surface model of an object, representing the inner 
cortical boundary. 
- Orient3D: Added a tool for making sure an object's surface model is in the same reference 
frame as its image data. 
- Surface3D: Added erode and dilate commands for editing segmentation labels. 
- Surface3D: Redesigned the interaction for editing segmentation labels. The paint and erase brushes 
now have correctly sized cursors and can be dragged for continuous painting/erasing. 
- Surface3D: All image segmentation editing actions can now be undone and redone. 
- Surface3D: Added a command to reverse the image slices (mirroring in Z dimension). 
- Surface3D: Fixed a bug causing incorrect voxel sizes for TIFF images loaded without a subject file. 
- Surface3D: Fixed a bug preventing the landmark widget from being enabled in some cases. 
- Surface3D: Fixed a bug affecting selection of segmentation labels when a second image file is 
loaded without a subject file. 
- X4D:  Made frame-by-frame tracking optimization 6 times faster when using CUDA (4D 
optimization not affected yet). 
- X4D:  Added option to select which GPU to use for each xray view. 
- X4D:  Added xray_opacity parameter for adjusting the opacity of xray images in all windows. 
- X4D:  DRRs can now be generated and processed on computers without a CUDA graphics 
card. 
- X4D:  Fixed a bug related to reading trial-specific xray/drr settings from a subject file. 
- X4D:  Fixed a bug preventing the "best pose so far" from being initialized with the starting pose. 
- X4D:  Fixed a bug related to adding poses to the "saved pose" list during ASA optimization. 
- X4D:  Fixed a bug preventing the program from launching if it was not on the primary monitor 
the last time it was closed. 
- X4D:  Fixed a bug related to applying the proper smoothing parameters when a pose map is 
reloaded from a file. 
 
Jul 3, 2018 (1.0.4.4277) 
- xManager: Fixed file association so a double-click on a .dsx file will launch xManager. 
- xManager: Fixed a bug that would give a false error message after a valid license activation. 
- CalibrateDSX: Added support for correcting xray images without performing uniformity 
correction. 
- CalibrateDSX: Fixed a bug related to a bad aspect ratio in the 2D windows when the trial data is 
asynchronous. 
- CalibrateDSX: Fixed a bug related to updating the applications when Edge Threshold or Centroid 
Threshold were changed. 
- CalibrateDSX: Fixed a bug related to the display of crosshairs for digitized POIs. 
- Locate3D: Changed the behavior of graphs (scaling, selecting, etc.) to match the behavior of X4D 
graphs. 
- Locate3D: Added support for Ctrl-click to force a POI at the clicked location. 
- Locate3D: Fixed a bug that caused a crash if POI pose maps needed to be interpolated when 
applying an object pose. 
- Locate3D: Computing object poses from POIs no longer interpolates POI pose maps to calculate 
poses for all reporting times. 
- Locate3D: Fixed a bug related to a bad aspect ratio in the 2D windows when the trial data is 
asynchronous. 
- Locate3D: Fixed a bug related to updating the applications when Edge Threshold or Centroid 
Threshold were changed. 
- Locate3D: Fixed a bug related to the display of crosshairs for digitized POIs. 
- Surface3D: The voxel size in image files can now be overridden by specifying the size in the subject 
file. 
- X4D:  Implemented generation of DRRs from surface models. 



- X4D:  DRR generation will happen on two GPUs if two GPUs are present. 
- X4D:  During an optimization, the DRRs in the 2D windows are now updated only when a new 
best pose is found (or when any user interaction causes a redraw event). 
- X4D:  Fixed a bug that was preventing DRRs from being generated for some TIFF CT image 
files. 
- X4D:  Fixed a bug that could cause a crash when switching between tracked objects in a trial. 
- X4D:  The DSX Configuration and Mocap Model widgets are now disabled during an 
optimization. 
- Save Dialogs: The choice of units is now saved in the file dialog when any file in which units are 
specified is written. 
- X4D:  "show mocap markers" no longer shows markers with empty names or names that start 
with "*". 
 
Apr 23, 2018 (1.0.4.4160) 
- PlanDSX: Implemented generation of DRRs from surface models. 
- PlanDSX: Added trackball interaction for manipulating objects in the scene. 
- PlanDSX: Made several improvements to how configurations are saved and imported. 
- X4D:  For x-ray files, can now read a folder of individual TIFFs instead of a single TIFF stack. 
- X4D:  "Local minima" poses are saved during bone tracking with ASA, and can be reviewed 
when tracking is complete (if the global minimum is not the correct pose). 
- X4D:  Added the “view_weighting” parameter so one view can be weighted more than the other 
during tracking. 
- X4D:  Fixed a bug related to initializing values in the Xray/DRR Settings widget. 
- X4D:  Added the option to linearly interpolate pose map splines. 
- Orient3D: Fixed the Miranda tibia LCS algorithm (sometimes the Y axis was backwards). 
- Orient3D: Fixed several bugs involving saving of the LCS to the subject file. 
 
Mar 13, 2018 (1.0.3.4054) 
- CalibrateDSX: Enhancements to output of 3D configuration calculation results. 
- CalibrateDSX: Bug fixes related to correcting large x-ray files. 
- Orient3D: Landmarks are now updated properly when the LCS is changed. 
 
Mar 07, 2018 (1.0.3.4045) 
- xManager: Several bug fixes. 
- CalibrateDSX: Enhancements to POI prediction and 3D configuration calculation. 
- Surface3D: Improvements to manual editing of segmentation and image rotation. 
 
Feb 20, 2018 (1.0.2.3986) 
- Bug fixes. 
- X4D:  Events are added to CMZ file to mark start and end of xray-based tracking. 
 
Feb 14, 2018 (1.0.1.3974) 
- xManager: Subject-object POIs can be imported from file. 
- CalibrateDSX: Added grid_centroid_min_size parameter for use in distortion correction. 
- CalibrateDSX: Renamed intensity_threshold parameter to white_threshold. 
- CalibrateDSX: Added image_threshold parameter for use in uniformity correction. 
- Surface3D: Added option to rotate the image. 
- Surface3D: Proper handling of re-saving segmented image when the initial segmented image is in 
DICOM format. 
 
Jan 31, 2018 
- Initial Release of DSX Suite, a Dynamic Stereo X-ray System. 
 
 
We would greatly appreciate your feedback. 

Please send bug reports and other comments to support@c-motion.com. 

mailto:support@c-motion.com

